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WaveLab 10.0.70 

March 2021 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-4746 
The Cue Point menu in the Edit tab of the montage window is now always 
enabled (WaveLab Elements/LE only). 

PAR-4744 Gain/Pan settings for reference tracks now work as expected. 

PAR-4743 Undoing metadata edits in the audio montage now works as expected. 

PAR-4742 
Using the Loudness Meta Normalizer in the audio montage no longer 
renders the application unreliable. 

PAR-4735 
Inserting a generic marker using a key command during playback now works 
as expected. 

PAR-4734 
Using the Spectrogram display on certain High DPI scaling settings no longer 
renders the application unreliable (Windows only). 

PAR-4733 
Closing WaveLab when using certain third-party plug-ins no longer renders 
the application unreliable. 

PAR-4706 CD frames can now be changed in the track list in the CD window. 
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WaveLab 10.0.60 

January 2021 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-4385 
GnuDb CD database support has been added to retrive Audio CD 
information when using CD import. 

PAR-4594 
An option has been added to restrict scaling values to integer ratios 
(Windows only). 

PAR-4583 Bitmap rendering on High DPI screen setups has been improved. 

PAR-4631 
Fixed an issue where RestoreRig DeNoiser settings were discarted  
when rendering to a new file. 

PAR-4621 
Help link now opens the correct URL when using WaveLab  
with Japanese language settings. 

PAR-4587 
The sample rate setting for the Live Input bus is now persistent when closing 
and reopening WaveLab. 

PAR-4581 
Fixed a waveform zoom issue when using a non integer scaling (e.g. 150%) in 
High DPI mode. 

PAR-4580 
"Insert Clip Files" by right-clicking on an audio montage track now works as 
expected. 

PAR-4575 
Fixed an issue where speaker configurations did not work under specific 
cirumstances. 

PAR-4522 Import of dual mono files now works as expected. 

PAR-4385 
Editing milliseconds time value in Compact mode in the Clock tab of the 
“Time Format” dialog now works as expected. 
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WaveLab 10.0.50 

November 2020 

This version contains the following improvements and issue 
resolutions. 

Improvements 

- Variable DPI scaling settings are now supported in WaveLab. 

- A new metadata variable for "Duration" has been added. 

- A new tooltip in CD Tool Window > Group column to display 
the Track Group Duration has been added. 

- Scalable vector graphics in CD report are now supported. 
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Issues resolved 

 

ID # Issue 

PAR-4508 
Using the "Open Selected Version in New Tab”  option in the History window 
for audio montages no longer renders the application unreliable. 

PAR-4504 Playhead now runs synchronized to audio playback as expected. 

PAR-4491 Inserting CD markers no longer renders the application unreliable. 

PAR-4485 
Analysis meters now show the resulting signal from the end of the process 
chain when using real-time rendering. 

PAR-4483 
Playback now always jumps to the right timeline position when switching 
between file tabs. 

PAR-4482 
The suffix label in “Multi Audio File Format” dialog now allows a space 
character. 

PAR-4477 
The “Catch Loudness from Audio Selection” option of the Loudness 
Normalizer now works as expected on a single channel selection in the 
Audio Editor. 

PAR-4476 
Handling of BWF Origination Date / Time in the Metadata dialog has been 
improved. 

PAR-4475 The “Insert Clip” and “Split Clip” options now work as expected. 

PAR-4473 The handling of RIFF metadata text encoding has been improved. 

PAR-4471 
Editing milliseconds time value in Compact mode in the Clock tab  of the 
“Time Format” dialog now works as expected. 

PAR-4469 
Importing clips via the “Stagger Files on Two Alternating Tracks (Linear)” 
option in the “Insert Audio Files” dialog now works as expected. 

PAR-4468 
WavPack encoding now works as expected with sample rates other than 
44.1 kHz. 

PAR-4367 
Saved projects now always appear in the  "Recent Project" list in the Startup 
dialog. 

PAR-4361 
Saved and restored Noise Print in a RestoreRig Denoiser preset no longer 
causes loss of audio playback. 

PAR-4346 
Plug-ins are now always activated when inserted on a montage track with 
monitoring enabled. 
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ID # Issue 

PAR-4324 WaveLab is now able to reset the bypass state of a preset saved in Cubase. 
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WaveLab 10.0.40 

June 2020 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-4325 It is now possible to delete audio files via the File menu. 

PAR-4318 
The “Revert to Saved File” option no longer renders the application 
unreliable. 

PAR-4295 
Clicking the preset icon of the Inspector’s plug-in slot now opens the presets 
menu as expected. 

PAR-4292 
A display issue in the “Audio Regions” section of the File Browser 
windowhas been fixed. 

PAR-4291 The “Convert to Stereo” option for envelopes now works as expected. 

PAR-4290 Restarting playback from the position of the cursor now works as expected. 

PAR-4246 
The reference track now works as expected when the main device port is set 
to plaback output bus #1 and #2. 

PAR-4241 Importing a video file no longer renders the application unreliable. 

PAR-4218 jBridge now works more reliably (not officially supported). 

PAR-4209 The envelope process in the Audio Editor is now displayed correctly. 

PAR-4200 
The “Use Existing Tracks (Create New Tracks If Necessary)” option to place 
files on separate tracks now works as expected. 

PAR-4195 MasterRig’s Saturator no longer causes audio glitches in silent regions. 

PAR-4193 
Duplicated tracks now also inherit the audio output routing of the original 
track. 

PAR-4321 Zooming in or out via the timeline now works as expected. 

PAR-4320 The format of timeline clock values has been improved. 



 

Version history Page 8 Steinberg Media Technologies GmbH 

ID # Issue 

PAR-4242 MasterRig’s Dynamic EQ now reacts correctly to parameter changes. 

PAR-4217 The waveform in the “Loop Tweaker” dialog now reacts to loop edits. 



 

Version history Page 9 Steinberg Media Technologies GmbH 

WaveLab 10.0.30 

March 2020 

This version contains the following improvements and issue 
resolutions. 

Improvements 

- The new “Folder Separator” naming scheme attribute in the 
“Naming Scheme” dialog allows you to create a folder 
structure according to the specified naming scheme. 

- The “Copy Clips to Track” option in the context menu of the 
track header allows you to copy all clips or only selected clips 
of a track to another track. 

- The new “Bounce” option for selected clips in the Process tab 
auf the Montage window allows you to render multiple clips 
to a single clip and the effects of a single clip to the clip. 

- The number of CD track groups has been increased from 10 
to 26. 

- For WAV and AIFF files, you can now specify the sample 
attribute gain in the “Sample Attributes” window. 

- The new “Reveal File in File Explorer/macOS Finder” option 
in the context menu of the file list in the “File Browser” 
window allows you to open the selected file in the File 
Explorer/macOS Finder.  

- The new “Play from Start of New Time Selection” option on 
the transport bar now allows you to play back a new time 
selection from the beginning of the selection instead of from 
the edit cursor position. 

- In the “Naming Scheme” dialog, you can now add hours, 
minutes, seconds, day, month, year, and the Master Section 
preset name as naming scheme attributes. 

- Since WaveLab 10, you can undo edits even after saving a file. 
Now the “Allow Undoing Edits after Saving File” option in the 
“Editing” tab of the “Audio Files Preferences” allows you to 
deactivate this function. This frees up disk space and 
removes all temporary files when saving. 
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Issues resolved 

 

ID # Issue 

PAR-4148 Using "All Clip Groups" rendering no longer gives unexpected results. 

PAR-4147 Rendered AIFF files now preserve the gain parameter value. 

PAR-4145 
"Save Plug-in Chain" with a plug-in window open now always preserves the 
state its parameters. 

PAR-4144 
"Reset Track Default Color" now works as expected from within the track 
inspector. 

PAR-4140 "Clone and Substitute" no longer renders the application unreliable. 

PAR-4138 
Importing AAC file with a corrupted audio header no longer renders the 
application unreliable. 

PAR-4134 The reliability of the playback bus configuration was improved. 

PAR-4130 
"Replace Clips with Rendered Audio Files " now works as expected on real-
time export. 

PAR-4124 The Loop Tweaker now changes the position of the involved loop markers. 

PAR-4122 Opening the Smart Bypass window no longer restarts playback. 

PAR-4119 Markers are now always copied when rendering an unnamed audio file. 

PAR-4117 Changing sample rate of all audio devices now works as expected.  

PAR-4114 
Bypassing the processing of clip effects with “Parallel Processing” as plug-in 
routing and "Fixed Gain " activated  no longer causes audio drop-outs. 

PAR-4111 Mono audio files are no longer played back over the left speaker only. 

PAR-4110 
Zooming in/out no longer causes the playhead to jump back to the 
beginning of an audio montage. 

PAR-4102 
Audio port dispatching for 8-channel audio montages now works as 
expected. 

PAR-4101 Factory presets for some VST3 plug-ins are now always displayed. 

PAR-4094 
Inserting/removing plug-ins could cause the playhead cursor to jump to the 
beginning of an audio montage. 
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ID # Issue 

PAR-4093 Drag-and-drop between file group tabs no longer causes a redraw issue. 

PAR-4091 File browser waveform display now works as expected. 

PAR-3693 
Analysis meters are now working as expected for track monitoring and real-
time rendering. 

PAR-4121 
The routing control tooltip on the montage track header now shows the actual 
routing configuration. 
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WaveLab 10.0.20 

February 2020 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-4066 Copy/Paste to an existing clip insert slot now works as expected. 

PAR-4058 The Playback Tool now plays the correct channels (left/right). 

PAR-4054 The Spectrometer audio selection monitoring now works as expected. 

PAR-4053 Loop-playback now works reliable. 

PAR-4050 
The Audio Connection device port mapping for a Surround setup now works 
reliable. 

PAR-4046 The rendering of multiple montages now works as expected. 

PAR-4045 
Zoom in/out with the mouse wheel in the Audio Montage has been 
improved. 

PAR-4044 Time grid is now drawn accurately. 

PAR-4034 The Save function is no longer disabled on newly imported audio files. 

PAR-4032 Real-time rendering of a selected CD now works as expected. 

PAR-4031 The option "move cursor back to start position" now works as expected. 

PAR-4030 “Insert true silence” no longer produces a click at start position. 

PAR-4029 
VST-2 plugins with a sample rate higher or lower than 44100 Hz are now 
being rendered correctly. 

PAR-4028 The rendering performance of UAD plug-ins has been improved. 
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ID # Issue 

PAR-4026 
Clip colors no longer get lost when using the edit history undo/redo 
commands. 

PAR-4021 The GUI performance on Mac systems has been improved. 

PAR-4020 The Edit/Repeat Clip function now works as expected. 

PAR-4010 
The clip envelope plug-in send automation no longer leads to distorted 
sound. 

PAR-4003 AES31 file import from Nuendo 10 AES31 files has been improved. 

PAR-3995 "Import Audio File to Montage" now works as expected. 

PAR-3993 Plug-in meters no longer freeze occasionally in loop-playback. 

PAR-3992 A duplicated audio clip no longer refers to the wrong file path. 

PAR-3987 Loop-playback now works more reliable while editing marker ranges. 

PAR-3976 Jog/Shuttle functions now work as expected. 

PAR-3938 Playback speed presets now work as expected. 

PAR-3931 
The clip tab columns in the clip tool windows now contain an auto size width 
behaviour when adding new clips to montage. 

PAR-3904 The preview function in the Audio CD import dialog now works as expected. 

PAR-3903 An issue related to the Loudness Meta Normalizer has been solved. 

PAR-3890 
WaveLab now displays message when using undo while recording in the 
montage. 

PAR-3633 
The waveform drawing in recording mode no longer stops at the end of the 
right track border. 

PAR-4042 A Multi Stereo recording mode has been added to the recording dialog. 

PAR-4057 
The Master Section Bypass is now considered by the edit history 
(undo/redo). 
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WaveLab 10.0.10 

November 2019 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-3951 It is now possible to customize the sample rate change time-out. 

PAR-3886 
New plug-in copy/paste buttons have been added to the Inspector window 
in the Audio Montage. 

PAR-3981 Detaching markers from an audio clip now works as expected. 

PAR-3979 Attached markers are now copied with the audio clip. 

PAR-3948 Drawing clip crossfades now works as expected. 

PAR-3947 
Accessing and editing the Audio File Preferences no longer renders the 
application unreliable. 

PAR-3945 Updating the smart bypass function now works as expected. 

PAR-3933 Overwriting closed audio files now works as expected. 

PAR-3932 It is now possible to play back unnamed rendered files. 

PAR-3921 
Deleting markers from the marker list in the Audio Editor no longer renders 
the application unreliable. 

PAR-3919 
Rendering regions between markers while using high-latency plug-ins now 
works as expected. 

PAR-3915 
Batch processes no longer need to be applied twice for a Watch Folder to 
work as expected. 

PAR-3914 
Drag and drop of audio clips and clip ranges between montages now works 
as expected. 

PAR-3912 
Clicking the CD-Text column in the CD window no longer renders the 
application unreliable. 
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ID # Issue 

PAR-3910 
Burning an Audio CD with activated  "Render to Temporary File before 
Writing" option no longer renders the application unreliable. 

PAR-3908 
Moving loop markers during playback no longer renders the application 
unreliable. 

PAR-3905 "Play All CD-Track Starts" can now be disabled during a session. 

PAR-3898 
Rendering a “Selected CD Track” as clip, track or output now also works for 
real time rendering. 

PAR-3897 
Editing an audio file that has been opened from an audio montage now 
works as expected. 

PAR-3895 
The option "Use Splice Markers" in the CD wizard no longer creates end 
markers as well. 

PAR-3893 
MasterRig meters fallback now works reliably when playback stops in the 
Audio Montage. 

PAR-3883 Steinberg CC121 now works correctly with WaveLab Elements. 

PAR-3882 Audio Analysis now works as expected. 

PAR-3865 
Copying multiple clips form one montage to another now works as 
expected. 

PAR-3854 Plug-ins are now restored correctly after saving and reloading a preset. 

PAR-3852 Remote control shortcuts are now displayed in WaveLab Elements. 

PAR-3839 
Importing or exporting an AES31 file no longer renders the application 
unreliable. 

PAR-3790 Fixed a graphical glitch in the plug-in preset menu. 

PAR-3658 Importing video files no longer renders the application unreliable. 

PAR-3579 Linking Master Section faders now works as expected. 

PAR-3572 MBit+ Dithering plug-in now supports high DPI. 

PAR-3461 
Saving a file group as a template no longer renders the application 
unreliable. 

PAR-3960 
Rendering a file when an External FX is being used no longer creates silence 
at the beginning of the file. 
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ID # Issue 

PAR-3926 The Resampler GUI is now always visible in the plug-in chain window. 

PAR-3983 
Inserting a UAD plug-in in the audio montage during playback no longer 
renders the application unreliable. 

PAR-3975 
The “CD Track Group” naming scheme attribute is now available in the 
“Naming Scheme” window. 

PAR-3949 
Playback cursor no longer becomes sluggish when applying changes in the 
Resampler.  

PAR-3944 Saving an audio file now shows a progress bar. 

PAR-3934 
The "Check for Updates" link now directs to the WaveLab 10 download 
page. 

PAR-3923 
The "Replace Selected Audio with Samples from This Version" option in the 
History window now works as expected. 

PAR-3864 
The "Keep Undone Versions" option in the History window now works as 
expected. 

PAR-3856 The GUI responsiveness of the Spectroscope has been improved. 

PAR-3843 Audio montage track meters no longer freeze in loop playback. 

PAR-3829 
Folding/unfolding the Montage window no longer affects the vertical zoom 
in the Montage window. 

PAR-3776 The Master Level now shows accurate digital peak values. 
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WaveLab 10.0.5 

October 2019 

This version contains the following improvements and issue 
resolutions. 

Issues resolved 

 

ID # Issue 

PAR-3858 
steinberg.help menu in WaveLab Elements now directs to the WaveLab 
Elements 10 documentation correctly. 

PAR-3878 WaveLab Elements now includes the new video engine. 
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